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Chapter 1. Wirecast Basics

Starting the Tutorial
Starting the Tutorial.
Thank you for taking the time to learn about Wirecast via this tutorial.
It is written to be as brief as possible to enable you to quickly get on the air with Wirecast.
This tutorial requires that you open a tutorial document in Wirecast.

If your Wirecast window does not look like the window below (with Ripples and River images), then you
should select “Create Document for Tutorial” from the Help menu in Wirecast.

3 Tutorial - Wirecast ===
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Live Broadcast Area

This area reprasents Wirecast™ output

Note

If you are running the tutorial with Wirecast in demonstration mode, the Wirecast logo will appear
from time to time and audio output will have a periodic voice-over.

The Main Window
Major areas of the main window.
¢ “Live Broadcast”

The large area on the top of the window is what Wirecast will broadcast to your viewers (or record
to disk).
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Wirecast Basics

¢ “Shot List”
The area on the bottom of the window which has icons is a Shot list. This list shows the available shots
that you can switch between.

3 Tutorial - Wirecast [ |2l |
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Live Broadcast Area
This area reprasents Wirecast™ output

What isa Shot?

Wirecast uses the concept of shots to construct your presentation.

A Shot contains media and settings for that media. A shot can be as simple as a still photo, or very complex
such as a live camera with a title and background music. In its simplest form, a Shot contains one piece
of media, such as a JPG.

Later, we will see how to edit shots to add media, and change some shot settings.

Shots are important because they allow you to configure a lot of information before production time. This
enables you to concentrate on creating a good production.

Switching between Shots.
Let’s use the shots that are loaded as part of the tutorial:

Click on the Shot with the icon labeled Ripples
— The Ripples image should fade in.

Click on the Shot with the icon labeled River
— The River image should fade in.

Click on the Shot with the icon labeled “Blank Shot”

Wirecast
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Wirecast Basics

— The River image should fade to blank.

We have included a “Blank Shot” for you to demonstrate that it is easy to show “nothing”.

Transition / Go Button

Transitions.

In the previous examples, a “fade” occurred when you clicked on a shot. This is because the default Tran-
sition “Smooth” was selected.

The area of the main window, shown below, controls your transitions:

Click on the River shot. It will smoothly fade in while the previous shot fades out.

Now click on the Ripples shot.

The Ripples shot should appear using the “Bowstring” effect.

You can change the transitions that appear in these three buttons by selecting another one from the menu.
You can either click on the small arrow to change the transition, or you can click on the button and drag

downward.

Change the first button (“Cut”) to be “Swoop” by clicking on the “Cut” button and dragging downward
until the popup menu appears.

Then select “Swoop” from the popup. Swoop should now be selected for the first button. Now try to click
back and forth between River and Ripples. So you have the ability to have 3 transitions at your finger tips.

These transitions are assigned to the following key combinations: Ctrl+1, Ctrl+2, and Ctrl+3 for quick
access.

Transition Speed.

You can also Control how fast a transition will occur, by using the Clock icon:

Choose “Slow” from this popup, and you’ll see the Clock icon change to look like this (a small turtle

means “slow”):

Now when you perform a transition, it should occur more slowly than before.

Go Button.

Wirecast

3 Telestream, Inc.



Wirecast Basics

The Go Button (or Ctrl+G) allows you to make a transition occur at any time. If you click it now, the
transition will occur between the shot and itself.

Layers
Layers.

[Before you start this section, please select “Smooth” as your transition, so that the effects you see are
as described.]

Wirecast allows you to use several layers.

Layers are drawn on top of each other (composited) in this order: Master Layer 1 is above Master Layer
2, and so on.

Open the layer panel by either clicking and dragging the “thumb” on the lower left side of the window,
or by selecting “Layer Panel” from the “Layout” menu.
D Totorial - Wirecast e
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Notice that you have been doing this tutorial so far on “Master Layer 3”.
Select Master Layer 2 by clicking on it.

Each shot is assigned to a layer. When you switch layers, you only see the shots that are on that layer. For
example, Ripples and River are on Master Layer 3, and Logo is on Master Layer 2.
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Wirecast Basics

You are now looking at shots on Master Layer 2.

Click on the Shot named “Logo”. Notice that the Logo will fade in on the top-right of the Live Broadcast
area, and should look like this:

And you should notice, in your Live Broadcast area that the Logo goes away.

Try clicking on it again, and watch the Logo come back into view.

Auto Live
Auto Live.

[Before you start this section, please make sure that all layers are visible (no red X through the layer icon),
and that you are on the “Normal” layer, which shows Ripples and River.]
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Master Layers

Up to this point of the Tutorial, Wirecast has been running in AutoLive mode.
What this means is that any change you make on the Main window is automatically made live.

This mode is very useful for those users who wish to set up all of their shots at once and then simply single
click on shots as they run their presentation.

The downside of this one-click method is that you are limited to only one shot change at a time. Once you
click on a shot, your viewers see it.

AutoLive was designed to address this issue.

Turn AutoL ive Off.

Turn AutoLive off by unchecking AutoLive in the Switch menu.

Now try clicking between the Ripples and River shots. Nothing happens.
Click on the Ripples shot—nothing happens.

Press the Go Button ... and Ripples becomes Live.

Click on the River shot. Nothing happens.

Press the Go button ... and River becomes Live.

Note

When AutoLive is off, you must always press Go (or Ctrl+G) to take any changes you have made
Live.
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Multiple Changes.

The benefit of having AutoLive off is that you can make several changes and have them occur at the same
time.

Let’s do several changes at the same time:

Verify that AutoLive is off, and click on Ripples (you should still see River in the Live window).
Now click on the “Title” Layer in the left Layers drawer, and click on “Sample Title”.

Now Press the “Go” button (or Ctrl+G).

Notice how both the Ripples Shot and the Sample Title Shot become Live at the same time:

3 Tutorial - Wirecast
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This is how you make several changes at the same time.

Preview
Preview.

One issue you may have had while you were performing the AutoLive part of this tutorial is that you could
not see the changes you were making.

AutoLive was off, so the changes weren’t Live. And you could only see Live.
To alleviate this problem, Wirecast allows you to see a Preview of what will go Live.

Select “Preview” from the “Layout” menu.
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Your main window should now look like this:

D Tutorial - Wirecast IE=niE=E
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The Left side that has the small green square with a “P” in it is the Preview area. The Right side is the
“Live Broadcast” area.

On the bottom left of the window, turn off Master Layer 1 and Master Layer 2 by unchecking the check-
boxes:

7 Tutorial - Wirecast ESRECE
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Notice how the Preview (left side), shows the changes you have made (you have hidden the Foreground
and Title layers). The Live area still looks as it originally did.

Now press the “Go” button. The Preview is taken Live, using the transition that you have selected.
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Chapter 2. Editing Shots

Editing Overview
Overview.

So far in this Tutorial, we have used only the Main window explaining the various ways in which you can
use shots. Next, we’ll begin to modify those shots.

All of the icons you clicked on in Wirecast Basics were shots. They were simply configured in different
ways. Some shots had only titles in them. Some shots had only a Foreground.

Your goal in creating a presentation in Wirecast will be to create the Shots you will use in your presentation
so that when you are presenting you are simply choosing, in real time, the shot you wish to use.

So on to Editing these shots.

Clearing the Slate.

Before we edit shots, let’s clear the slate.

Select “Create Document For Tutorial” from the “Help” menu.
Shot Editor Overview.

Double click on the Ripples Shot.

This opens a shot editor for the Ripples shot.

Note

If you save a document with the window open, Wirecast remembers this and will re-open the edit
window when it the document is re-opened.

73 Ripples - Editing | ]
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Editing Shots

This window has three main areas:

1. Shot Preview Area (Top)
This area depicts exactly what this shot will look like to your viewers if you were to make this shot live.

2. Source Layers (Bottom Left)
This area allows you to add, remove, and reorder the sources in your shot.

Sources are ordered visually from top to bottom. For example, the first source in the source list will
appear on top of all other sources the preview.

In addition, this area controls visibility of each of the elements. Click on the icon for a source and it
will become invisible.

3. Configuration Area (Bottom Right)

The configuration area changes appearance depending on the selected Source layer. This is where you
make changes to the content of the shot, and it's parameters.

Layers
Layers.

The bottom left part of the shot editor window controls the sources you have in your shot.
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Click on the Logo icon. Notice what happens to the Shot Editor Preview—it changes to show you the Logo.
Click back on Ripples, and you’ll see that the Preview switches to Ripples.

You are changing the Media for the first source layer in this shot.

=]

Now click on the icon (in the header of the bottom left area of the window). This will open the
template window:
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Editing Shots

Tempiates | virtual Sets
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Select the "Angled In" template and press the Apply button.

Notice the Preview has changed again, to show your Ripples image on the Left side:

D Ripples - Editing o ]
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As you can see, sources in Wirecast can be assigned either "A", "B" or "C" in the Source list (just click
on the A/B/C to change the designation).

This makes choosing a new template must simpler, as Wirecast can automatically position the correct
sources on screen.

Now, let's change the Media for the source that currently is tagged as "B". Make source that the first source
in the list is selected (it should be "B"), then click on the River image in the media bin to the right.

Your Preview should now look like this:

Wirecast
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Editing Shots

3 Ripples - Editing | )

Titles
Titles.

You can add a Title to a shot.

Click the "+" button on the bottom of the Source list to add a new layer, as shown here:

D Ripples - Editing | ]
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To add a Text template, select the "T" from the media segment control:

Wirecast 13
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Editing Shots

Select the template called "Blue Banner 3" and your preview will look as follows:
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If you add some text, you'll see the following in your preview.

Next click on the "T" icon on the header of the Attributes bar, you'll be able to edit text, as shown here:

Wirecast
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Editing Shots

Now, let’s position the Title...

Effects/Motion
Positioning Objects.
The sources in a shot can be positioned on screen. In the example here, we’ll position a Title.

Make sure the the Title layer in the Sources list on the bottom left of the window is selected. Now click
on the on “Effects” tab in the Shot Editor.

Sorces Bl | Attbutes e B T T L (1
B B e > o
(R ro=ms A, on| ] ome e e

#[ 8%

| REspect Aspect Raso

" Reset Poston Saske To Fit Herizortsl Fig |

In this view, the Title element is positioned in the bottom middle of the screen.

To move objects, you can use the mouse in the preview area at the top of the window. Click on the preview
and while holding the mouse button down, move the mouse.

Here are the options you have while holding the left mouse button down:
* Move — Move the mouse in the preview area
* Resize while respecting aspect ratio — Hold key down while moving the mouse vertically

» Resize Freely — Hold key and Shift key down while moving the mouse horizontally and vertically
(only works if “Respect Aspect Ratio” is disabled on Channel’s Effects tab)

* Rotate — Hold down key

The Arrow widgets can help reposition the title around the window:

LNl
/o=
2] $]%]

Other options are relatively straightforward. Some of them may not be useful for a Title, but will be helpful
as you work with other objects.

Mation for Objects.

All Objects (Such as the Title object) can have motion assigned to them.
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Click on the “Motion” Tab, your window should look like this:
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Motion will only occur during a transition. (when you have pressed “Go”, or if AutoLive is on and you

change a shot).

It occurs when the shot-element (a title in our case) needs to be added or removed from Live. It defines
how that adding (Build-In) or removing (Build-Out) will occur.

There are two forms of Motion:

1. Build In

Build In motion occurs when the shot-element (Title, in our case) is taken Live when it does not already

exist in Live.

2. Build Out

Build Out motion occurs when the shot-element (Title, in our case) was Live and at the end of the
Transition will no longer be Live

You’ve been using build-in and build-out already—when you clicked between shots when you first opened
Wirecast the default behavior was occurring—Fade-In and Fade-Out.

Changing Motion Options.

Let’s Change that behavior, Change the Build-In parameters by selecting “Left” from the popup and check-

ing “Decelerate In”:

Build In

[From Left -

Fade In

[ spin In

[ 5cale In
Decelerate In

Wirecast
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Editing Shots

To see this behavior in action, you must go back to the main window and trigger the Build-In.
Here’s how to trigger it:

1. In the Main window, make sure “Smooth” is the Transition.

2. Click on the Blank Shot.

3. Click on the shot you’ve been editing.
Notice that when the Title appears it now has motion.

Wirecast 17 Telestream, Inc.



Chapter 3. Broadcasting

Concepts

There are two main components for broadcasting or saving to disk:

1. Encoder Preset—You need to decide how you are going to encode the broadcast
This means what type of compression you’ll use—say, JPEG or MPEG4, etc.

Wirecast comes configured with many common encoding styles.
For now, just select one of these defaults.

2. Destination—You need to decide the destination of the broadcast
Will you save it to disk? Will you send it to a server to be reflected to your users?

Broadcast Settings.
Select “Broadcast Settings” from the “Broadcast” menu (or Ctrl+Y).

Here’s the window you’ll get:

T Breadeast Seftingt = [ |
Broadcast  Asnelabore
Dentraton Fremet Aate
e rmpsMocalhost] 935 e Stream: myStresm Flashs Mlecium Bamchwidth 49k
* | - &~
Ersnder Preset: | Flash Medhum Bandwid B T Edit
Destrabion: |RTMP Flash Servel A
Address:  rimpeifocalhost: 1935 ve
Srean: |mySiream Dpen FMLE XML File
Jser Agent: | WirecastFM 1.0 = Set Credeniiais. ..
| zave Cancsl g

The top part of the window is where you can add multiple settings for the same broadcast.

You might use this to create a broadcast with many bit-rates (for users who may be on different internet
connections). You might also use this to record to disk as the same time as you create your presentation.

The “Encoder Preset” popup defines how your broadcast will be encoded (what “codec” to use). We have
put some sample ones in here. For now, let’s just use the default.

QuickTime/ Windows Media.

At this point, depending on the Encoding you’ve selected, you’ll have to either configure QuickTime or
Windows Media.

Continue with Flash information

Continue with QuickTime information

Wirecast

18 Telestream, Inc.
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Continue with Windows Media information

Flash Streaming

Flash Streaming.

7 Breadeast Seftings i ]
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If you select an encoding preset that uses Flash, you’ll be presented with the above window.

Shown above is the generic Flash streaming server configuration. Wirecast can stream to several Flash
streaming servers, such as Flash Media Server (Adobe) and Wowza Streaming Server (Wowza).

Encoder Preset.
This is the codec presets that you have chosen for this destination.

If you change the preset to another code type (i.e., QuickTime), then the list of destinations will change.
The destinations are tied to the type of codec you are using.

Destination.

There are several custom destinations for some CDNs and Live streaming websites. You will need to have
an account with the specific service if you'd like to use that service. Shown above is the generic RTMP
Flash Media Server destination.

You may also select "Record to Disk" as a destination for the stream.
Address.

The RTMP address of the Flash Media Server. Contact your Flash Media Server administrator for this
URL.

Stream.

Each Flash stream requires that you enter the name of the stream. Contact your Flash Media Server ad-
ministrator for the name of your stream.

Open FMLE XML File.

Wirecast can load configuration files that have been created for Flash Media Live Encoder (FMLE).
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Wirecast will read the RTMP Address and Stream Name from this file. Wirecast will not read any other
configuration information from the FMLE XML file (such as bit rates, or codec configuration).

Many popular sites provide an FMLE configuration file for your stream configuration.
User Agent.

Although rare, some streaming services require that Wirecast presents itself as FMLE when broadcasting.
By default, Wirecast correctly presents itself as "Wirecast/FM 1.0"

Do not change this unless your provider has asked you to do so.
Set Credentials.
Some Flash Media Servers require authentication.

Wirecast offers the standard Adobe authentication method, and if your server requires it you may enter
your credentials here.

If your server does not require authentication, there is no need to set credentials.

QuickTime Streaming

QuickTime Streaming.
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If you select an encoding preset that uses QuickTime, you’ll be presented with the above window.
There are five destinations available:

1. Announce to QuickTime Streaming Server
This will talk to a QuickTime Streaming Server and use the server to “reflect” the broadcast to users
who view that server.

2. Built-in Streaming Server
Wirecast includes a built-in streaming server which will allow a small number of viewers to view your
broadcast. Just define the name of the SDP file and you can immediately broadcast.

Wirecast
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3. Unicast
This will broadcast directly to one single client (computer). You must define the address for the single
client, and the presentation is streamed directly to this machine.

4. Multicast
This is an advanced feature that will broadcast “globally” on a network. In a LAN environment, this
option can provide the ability to broadcast to multiple users without using QuickTime Streaming Server.
This feature will only work over a LAN and not over the Internet.

5. Record to Disk
If you’d like to save your broadcast for archival purposes, you can use this option to record the stream
to disk.

Announceto QuickTime Streaming Server.

As this is the most common method for QuickTime, you should investigate using this option for your
broadcasting

To use this feature, you must supply a host name and file location. Only if your server requires a login do
you need to supply a user-name and password.

This feature requires that you have access to a QuickTime Streaming Server (QTSS) or Darwin Streaming
Server (DSS). Darwin Streaming Server is a free download from Apple and can be installed on several
operating systems (not just Macintosh).

Unicast.

Unicast is used to broadcast to only one other computer.

The steps you take to do Unicasting are as follows (this is covered in more detail in the documentation):
1. You must know up front the address of the client computer, and configure this.

2. You need to save an SDP file (use the “action” popup near the top right of the window), and give that
SDP file to the user for the other computer

3. You start broadcasting your presentation.

4. On the client machine, open the SDP file with QuickTime Player and they will see your stream.

Note
If you change any setting regarding the broadcast (encoding settings, etc), you must re-create the
SDP file.

Multicast.
Multicast is used to broadcast to any computer on your local network (not on the internet).

To use this feature, you must create and distribute an SDP file to all users on your local network who
wish to view the stream.

The Video Address and Audio Address (and related ports) are, effectively, “fake” addresses that do not
really exist on the local network. This information is stored in the SDP file so that client applications know
“where to look” for the stream. The default addresses/ports that Wirecast generates are generally OK to use.

The steps you take to do Unicasting are as follows (this is covered in more detail in the documentation):

Wirecast
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1. You must know up front the address of the client computer, and configure this.

2. You need to save an SDP file (use the “action” popup near the top right of the window), and give that
SDP file to the user for the other computer

3. You start broadcasting your presentation.

4. On the client machine, open the SDP file with QuickTime Player and they will see your stream.

Note
If you change any setting regarding the broadcast (encoding settings, etc), you must re-create the
SDP file.

Record To Disk.
If you wish to archive your stream, you can use this destination.
Simply enter the name of the file and you are ready to go.

If you use “Auto Increment Filenames” then the files will be saved with a number at the end of them.

Windows Media

Windows M edia Streaming.
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If you select an encoding preset that uses Windows Media, you’ll be presented with the above window.

Note

Windows media options are only available when running on a Windows operating system.
There are two destinations available for Windows Media:

1. Network
The stream will be broadcast over the network, either using a server or using your local machine.

2. Record to Disk

Wirecast
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Broadcasting

If you’d like to save your broadcast for archival purposes, you can use this option to record the stream
to disk.

Networ k—Push to Server.

To use this option, you must have access to a Windows Media Server, either in your organization or housed
by an ISP (search the internet for “Streaming Windows Media Server”).

This is the “industrial strength” way of creating a stream as it puts the bandwidth strain on the remote
server. All you need is a good local connection to the internet to push to the Windows Media Server.

To configure this setting, you enter the Internet address of the remote server, the publish point (the ’file
name’ will be part of the URL that your users use to start the presentation), and any user-name/password
you have with the ISP.

If you check “Auto Remove” then when the presentation is completed, the publish point is removed (file
deleted) from the server.

Networ k—Pull from Server.

This option turns your local computer into a mini Windows Media Server — you can broadcast immedi-
ately.

However, there are some caveats:
¢ Maximum 50 users—You cannot have more than 50 connected users

* Bandwidth—You must have enough bandwidth between the machine Wirecast is on and all of your
viewers.

* CPU—The machine is acting as a server and to that extent, some CPU is used per connection (though
not much).

The largest issue is with using this method is bandwidth. If, for example, all of your viewers are on a local
network (a business or school), then you should be able to use this method.

If you have a DSL connection to the internet and you want to broadcast a 200k stream to 20 viewers, you
will simply not have enough upload bandwidth to accommodate this.

Note

Be aware that when you use Wirecast with an internet connection what matters is your upload
bandwidth. Most ISP businesses offer packages that have a higher download than upload band-
width (e.g., a 512k DSL package is often only 256k upload).

To use this option, simply set the port number that your users will use to connect to your machine. They
will connect to your machine by using the “Open URL” option in Windows Media Player, and enter an
URL like this: mms://192.168.1.67:8080 (assuming your machine is 192.168.1.67 and your port is 8080).

Note

The URL “mms://”” does not work with the Macintosh version of Windows Media Player, and
you must use “http://” instead.

Record To Disk.
If you wish to archive your stream, you can use this destination.

Simply enter the name of the file and you are ready to go.

Wirecast
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Broadcasting

If you use “Auto Increment Filenames” then the files will be saved with a number at the end of them.

Summary—Thanks for following the tutorial!
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Chapter 4. Summary

Thank you!
This tutorial took you through the major functionality that Wirecast offers to the first time user.
There are many features left for you to discover, but this should get you on your way.

See our full documentation (Available from the Help menu) for more detailed information on any of the
above subjects.
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